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Trademarks  
©2011 Ambir Technology, Inc. All rights are reserved.  

 

All trademarks and brand names mentioned in this publication are property 

of their respective owners. ImageScan Pro 820i User's Guide Ambir_Ver 1.3.doc 

 

 

Liability  
While all efforts have been made to ensure the accuracy of all contents in 

this manual, we assume no liability for errors or omissions or by statements of 

any kind in this manual, whether such errors are omissions or statements 

resulting from negligence, accidents, or any other cause. The contents of this 

manual are subject to change without notice. We will not bear any legal 

liability if users fail to follow the operation instructions in this manual.  

 

 

Copyright  
The scanning of certain documents, e.g. checks, bank notes, I.D. cards, 

government bonds, or public documents, may be prohibited by law and/or 

subject to criminal prosecution. Please be responsible and respectful of 

intellectual property and copyright laws when scanning books, magazines, 

journals and other materials.  

 

 

Environmental Information  

  

Ambir Technology is committed to the environment. This 

product is designed and produced to achieve 

sustainable environmental improvement. We strive to 

produce products in compliance with global 

environmental standards. Please consult your local 

authorities for proper disposal. Our product packaging is 

recyclable.  

 

 

Screen Examples in This Manual  
The screen shots in this guide were made with Windows XP. If you are using 

Windows 7, Vista or 2000, your screen may look somewhat different but 

functionality is not affected.  
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INTRODUCTION 
Thank you for purchasing an Ambir scanner. We have designed this product 

to provide you with an effective tool to capture, manage, and archive 

documents of many types. We encourage you to read this important User’s 

Guide carefully.  

How to Use This Guide 

This User’s Guide provides instructions and illustrations on how to install and 

operate your scanner. This guide assumes the user is familiar with Microsoft 

Windows 2000 Professional/ XP/ Vista/ 7.  

The Introduction section of this manual describes the box contents and 

minimum system requirements to use this scanner. Before you install your 

scanner, check the box contents to make sure all parts are included. If any 

items are damaged or missing, please contact the point of purchase.  

Chapter I describes how to install scanner’s software and connect the 

scanner to your computer. Note: The scanner connects to your computer 

through a Universal Serial Bus (USB). If your computer does not support USB 

technology, you will need to purchase a USB interface card to add USB 

capabilities to your computer, or buy and install USB connectors if your 

motherboard has USB capabilities. This guide assumes that your computer is 

USB-ready and has a free USB port.  

Chapter II describes how to use your scanner.  

Chapter III describes how to maintain and clean your scanner.  

Chapter IV contains technical support information that can help you solve 

simple problems.  

Appendix A contains the specifications of the scanner you purchased.  

Appendix B contains our customer service, the limited warranty agreement 

and FCC statement concerning the product.  

Guide Conventions  

Bold – Represents commands or contents on your computer screen.  

ALL CAPS – Important note or first use of an important term in a chapter.  

Italic – Represents buttons on your scanner OR important notes.  
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A Note About Icons 

This guide uses the following icons to point out information that deserves 

special attention.  

 
 

 
Warning 

  

A procedure that must be followed 

carefully to prevent injury, or 

accidents.  

 
Attention  

Instructions that are important to 

remember and may prevent mistakes.  

 

 
Information  

 

Optional tips for your reference.  

 

Safety Precautions 

 

  

Warning 

 

Before using this device, please read the 

following important information to 

eliminate or reduce any possibility of 

causing damage and personal injury. 

 

1. The product is for indoor use in dry locations. Condensation may occur 

inside this device and cause malfunction if the following conditions are 

met:  

 when the device is moved directly from a cold to a warm location;  

 after a cold room is heated;  

 when this device is placed in a damp room.  

To avoid condensation:  

i. Seal this device in a plastic bag for it to adapt to room conditions.  

ii. Wait for 1-2 hours before removing this device from the bag.  

2. Use the AC adapter and USB cable provided with the scanner. Use of 

other AC adapters and cables may lead to malfunction.  

3. Keep the space around the AC adapter clear in case you need to quickly 

unplug the AC adapter during an emergency.  

4. A damaged wire could cause fire or electrical shock. Keep the power 

cord straight and avoid placement where it could lie twisted or bent.  
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5. Unplug this device if you don’t need to use it for an extended period of 

time to avoid any risks of causing a fire.  

6. Do not attempt to disassemble the scanner. There is danger of electric 

shock. Opening your scanner will void your warranty.  

7. Be sure not to bump or knock the scanner glass as it is fragile and could 

break.  

8. Do not subject the scanner to excessive vibration. It may damage the 

internal components.  

Minimum System Requirements1 

 PC with Pentium
®
II processor (Pentium III processor recommended)  

 1GB RAM or higher 

 Available USB 2.0 port  

 CD-ROM Drive or DVD-ROM Drive  

 800 MB Free Hard Disk Space  

 Video card that supports 16-bit (high) color or greater  

 Operating System: Windows 7, Vista, Windows XP Home, Windows XP 

Professional, Windows 2000  

                                                 
1 Higher requirements may be needed when scanning or editing large quantities of images. The 

system requirements stated are only a guideline, generally the better the computer (motherboard, 

processor, hard disk, RAM, video graphic card), the better the results. 
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Box Contents2 

  

1. Scanner 

2. USB Cable 

3. AC Adapter 

4. Stacker 

5. Quick Start Guide 

6. Setup/Application CD-ROM 

7. Calibration Sheet 

8. Memo Label 

9. Extended Paper Width Slider (2 pieces) 

10. Padded Carry Bag (Not included with all scanner models) 

11. Cleaning Cloth 

12. Pad Module (Not included with all scanner models) 

                                                 
2 Save the box and packing materials in case you need to transport the scanner in the future. 
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Scanner Features  

  

1. PAPER CHUTE COVER—Helps keep the paper in place. Open paper chute 

cover when using the scanner.  

2. PAPER WIDTH SLIDER—Adjusts the paper width slider for the paper size you 

are using. 

  

 

Information 

 

2. Extended Paper 

Width Slider 

(accessory in the box 

contents) – Holds the 

paper upright to 

avoid crooked paper 

feeding. 

 

3. COVER LEVER—Opens the ADF cover. Pull it to open the ADF cover when 

you need to clear paper jam or clean the scanner.  

4. STACKER—Keeps paper in place. Extend it in case of longer paper.  

5. ADF (AUTOMATIC DOCUMENT FEEDER)—Automatically feeds a stack of 

documents for scanning.  

6. SIDE GUIDE—Holds paper in place while being fed through the ADF. Pull 

side guides out to hold the paper.  

7. PAPER CHUTE EXTENSION—Extends to hold longer paper. 
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8. UP BUTTON—Press to move forward 

the scanning task number indicated 

in the function number display.  

9. DOWN BUTTON—Press to move 

backward the scanning task number 

indicated in the function number 

display.  

10. FUNCTION NUMBER DISPLAY—

Indicates the number of the 

predefined scanning task selected 

by the up or down button.  

 

11. SCAN BUTTON—Press to perform a predefined scanning task selected by 

the up or down button.  

12. POWER LED—Indicates scanner status.  

  

Light Status 

Green Scanner is turned on and ready to scan images 

Orange Scanner in standby mode (sleep mode) if idle for 10 minutes  

Off Scanner is off, either because the power is not on or the AC 

adapter is not properly plugged into an AC power outlet. 
 

 

13. HANDLE—

Ergonomically 

designed for you to 

carry the scanner 

with ease.  

14. USB PORT—Connects 

the scanner to a USB 

port on your 

computer via the 

included USB cable.  

 

15. POWER RECEPTOR—Connects the scanner to a standard AC power outlet 

via the included AC adapter.  

16. POWER SWITCH—Use this to turn the scanner ON or OFF.  
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CHAPTER I. INSTALLING THE SCANNER  
Before installing your scanner, please verify that you have all of the proper 

components. A list of the package contents is provided in the ―Box 

Contents‖ section of this guide.  

Software Installation Requirements  

Your scanner comes with the following software: 

 Scanner driver and button management software (AmbirScan ADF), 

 OCR software (ABBYY FineReader 9.0),  

 Document management software (NewSoft Presto! PageManager). 

These software applications use approximately 400 megabytes of hard disk 

space after they are installed into your computer. To ensure ample room for 

the installation, as well as for scanning and saving images, a minimum of one 

(1) GB of hard disk space is recommended.  

This USB scanner only works with Microsoft Windows 7/Vista/ XP/2000 

operating systems.  

Hardware Requirements  

This scanner connects to your computer through the Universal Serial Bus (USB) 

which supports HOT PLUG AND PLAY. To determine whether your computer is 

USB-capable, you must check the rear of your PC to locate a USB jack that 

looks like the picture below. If you are having trouble locating the USB port 

on your computer, please refer to the hardware manual that came with your 

computer.  

Upon examination, you should find one or two rectangular USB ports, which 

usually appear as shown below.  
 

 
USB Connector(s) 
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Scanner Installation and Set Up  

 

 

Attention 

 Place your scanner on a smooth, level and 

solid surface before going through the 

installation process.   

 Tilted or uneven surfaces may cause paper 

feeding errors, scanner damage or personal 

injury. 

 Avoid using the scanner in a dusty 

environment. Dust particles and other foreign 

objects may damage the unit. 

Step 1.  Connecting the Scanner to Your Computer 

 

 

Attention 

 

Please make sure the scanner is turned OFF 

before you plug or unplug the scanner power 

adapter.   

 

1. Plug the AC adapter into the scanner’s power receptor.  

2. Plug the other end of the AC adapter into a standard AC power outlet. 
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3. Plug the square end of the included USB cable into the USB port  at 

the rear of the scanner. 

4. Plug the rectangular end of the USB cable into an available USB port on 

your computer. 

5. If you plan to connect your scanner to a USB hub3, make sure the hub is 

connected to the USB port in your computer.  Next, connect the scanner 

to the USB hub. 

Step 2.  Installing the Software 

1. Switch on the scanner power from the rear of the scanner. 

2. If the USB components on your computer are functioning correctly, they 

will automatically detect the scanner causing the Add New Hardware 

Wizard or Found New Hardware Wizard to launch. 

 

3. For Windows 7: 

a. When the Setup/Application CD is for several scanner models: 

i. Insert the Setup/Application CD-ROM, included with your 

scanner, into your CD-ROM drive. Click Run install.exe in the 

AutoPlay window. 

ii. Click on the Yes button if the User Account Control dialog 

pops up. Follow the instructions in the pop-up installation 

message. 

iii. In the Device Manager window, right-click on this scanner 

under Other devices and select Update Driver Software from 

the pop-up menu. Click Browse my computer for driver 

software in the window that appears, and click the Browse 

button. 

iv. In the Browse For Folder window, select the folder or the CD-

ROM drive that contains this scanner’s driver and click the 

OK button to return to the previous screen. Click the Next 

button and click Install this driver software anyway if the 

Windows Security window appears. Please skip to step 8. 

b. When the Setup/Application CD is for one scanner model 

i. Insert the Setup/Application CD-ROM, included with your 

scanner, into your CD-ROM drive. Click Run install.exe in the 

AutoPlay window. 

ii. Click on the Yes button if the User Account Control dialog 

pops up. If the pop-up wizard window appears click Next, 

and click Install this driver software anyway in the Windows 

                                                 
3
 A USB hub is not included with the scanner. 

 

Information 

If your computer is off when the scanner is 

connected, the ―Add New Hardware Wizard‖ 

message will not be displayed until the 

computer is on and Windows starts. 
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Security window then click Finish in the wizard window. 

Please skip to step 8. 

4. For Windows Vista: 

a. Select ―Locate and install driver software (recommended)‖ when 

the ―Found New Hardware‖ window is displayed. 

b. Click the Continue button when the ―User Account Control‖ dialog 

pops up. 

c. Insert the Setup/Application CD-ROM, included with your scanner, 

into your CD-ROM drive when the system prompts you ―Insert the 

disc that came with your USB Scanner―, and click on the [Next] 

button. Please skip to step 7. 

5. For Windows XP: 

a. Insert the Setup/Application CD-ROM, included with your scanner, 

into your CD-ROM drive. 

b. Select Install the software automatically (recommended) and click 

the Next button. 

c. Click the Next button in the window that appears. 

6. During the installation process the message ―Windows can’t verify the 

publisher of this driver software‖ might appear.  Click Install this driver 

software anyway to continue the installation. 

7. When the system completes the installation, click the Finish button. 

8. Follow the on-screen instructions to install all the software your new 

scanner requires. 

9. After you install the software, close all open applications and click the 

Finish button to restart your computer. 

 

10. After the computer restarts, you will be 

prompted to calibrate the scanner. 

11. Insert the special calibration sheet into the 

scanner’s document feeder, with arrows toward 

the scanner buttons. 

 

12. Follow the on-screen instructions to complete 

the scanner calibration. After calibration is 

complete, click OK and then click Finish. 

 

 

  

 

Information 

If scanner installation doesn’t start 

automatically, click Start, select Run and 

type in D:\Install (where D: is the drive letter 

assigned to your computer’s CD-ROM drive). 
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Step 3.  Installing the Extended Paper Width Slider 

1. Open the ADF cover by pulling the gray lever, and get the right and left 

extended paper width sliders ready.  

 

2. Align and insert the left extended paper width 

slider onto the paper width slider on the left. 

Position and insert the right extended paper 

width slider onto the paper width slider on the 

right. 

 

 

 

 

3. Close the ADF cover by pushing it back down 

until it snaps back into place. 

 

 

 

 

 

Step 4.  Installing the Stacker 

 

 

Information 

Stacker installation is optional. 

 

Insert the tabs on the stacker into their slots on the 

scanner. 
 

 

 

 

Installing Additional Software  
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Your scanner is TWAIN compliant and functions with virtually all available 

TWAIN compatible software. If you purchase additional software to use with 

your scanner, please make sure it conforms to the TWAIN standard.  
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CHAPTER II.  SCANNING  
Your scanner needs to be driven by certain type of software program. Since 

all documents or images (whether text or pictures) that are acquired from 

the scanner are treated by your computer as images, most scanning will 

probably be done from an image-editing program where you can view, edit, 

save and output the scanned images. An image-editing program has been 

bundled for your scanner on the included Setup/Application CD-ROM. It will 

allow you to alter and correct any scanned images by using a variety of 

filters, tools and effects.  

 

What about scanning text documents and editing them in a word 

processor? This is the role of Optical Character Recognition (OCR) software. 

OCR software converts the image files that are created from scanning text 

documents into text files that can be viewed, edited and saved by word 

processors. ABBYY FineReader 9.0, an OCR program, has also been bundled 

on the included Setup/Application CD-ROM, and if you wish to use the 

scanner in this way you should install this software.  

 

The AmbirScan ADF program seamlessly integrating the operation of your 

scanner with your computer and other peripherals, provides a quick and 

convenient way to perform various scanning functions. With AmbirScan ADF, 

you don't need to adjust settings every time you scan. Simply press any 

button on the scanner's front panel or click any scanning menu item of 

AmbirScan ADF on the screen. The scanner starts to scan your paper 

documents and transfer them to your assigned destination. The destination 

can be a printer, your E-mail program, files on your disk drives, an image-

editing program, etc.  

 

This chapter describes three important steps of scanner operation. Read 

them thoroughly and follow the instructions to ensure correct use and 

optimal scanner performance.  

Step 1. Preparing Documents 

Step 2. Loading Documents, Loading Business Cards, Loading Plastic Cards 

Step 3. Scanning Documents  
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Preparing Documents  

Proper document preparation prior to the scan can prevent paper feed 

errors and damage to the scanner.  

Checking Document Conditions  

Make sure the size and ream weight of your documents meet the 

requirements stated in Appendix A. Refer to ―Appendix A: Specifications‖ of 

this guide for more information.  

Scanning multiple documents in a batch using the ADF can increase your 

work efficiency and make large scanning tasks easier. The ADF accepts a 

variety of paper and stationery you may use in your daily work or personal 

life, such as:  

 Normal paper whose size and ream weight meet the requirements 

stated in ―Appendix A: Specifications‖ of this guide. 

 Notched paper 

 Coated paper (e.g., brochure) 
 

 

Attention 

To prevent paper feeding errors and damage to 

the ADF unit, strictly follow the instructions below: 

 Remove all small objects (e.g. paper clips, 

pins, staples or any other attached fasteners 

before loading the paper into the ADF.   

 Make sure paper is completely flat with no 

creased or curled corners 

 Avoid scanning documents with pencil lead 

and newspaper clippings as they will make the 

ADF exposure glass and the inner ADF dirty. If you 

have to scan such paper, clean the scanner 

frequently (refer to ―Chapter III. Care and 

Maintenance‖ of this guide for more 

information). 

 The paper for each batch scanned by ADF 

can be of the same or different weights. 

However, make sure the length of each scan 

batch is the same. 

 

Don’t use the ADF to scan documents if they meet any of the following 

conditions: 

 Paper lighter that 14 lb. (50 g/m2) or heavier that 28 lb. (105 g/m2) 

 Paper with clips or staples attached 

 Paper with inconsistent thicknesses (e.g. envelopes) 

 Paper with wrinkles, curls, folds or tears 
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 Paper with an odd shape (non-rectangular) 

 Tracing paper 

 Carbon paper, pressure sensitive paper, carbonless paper 

 Items other than paper (e.g. cloth, metal, foil) 
  

 

Attention 

 DO NOT use the ADF to scan photographic 

sheets or particularly valuable document 

originals; feeding errors may cause wrinkles 

and/or tearing.   

 DO NOT place paper with wet ink or 

correction fluid into the ADF. Wait a few 

minutes for it to get dry. 

 
  

Loosening Documents  

Before loading documents into the ADF, loosen them as follows:  

1. Fan the documents so that no two pages are sticking together.  

 

2. Hold the documents upside down with both 

hands, and then gently push them onto a flat 

surface to align the edges of all documents. 

 

 

 

This will allow documents to feed into the ADF one at a time and reduce 

paper-feeding errors.  
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Loading Documents 

 

1. Load the documents, headfirst and face down, 

toward the center of the ADF paper chute and 

all the way into the ADF until touching the 

bottom.   

For single-sided scans, load the documents face 

down so that the side to be scanned faces 

towards the paper chute.   

For double-sided scans, load the desired page 

order of documents face down so that the side 

to be scanned faces towards the paper chute. 

 

 

 

 

2. To scan longer documents, unfold the paper 

chute extension and side guide to provide 

further support for the documents.  

 

 

 

 

 

 

3. Adjust the paper width slider for the paper 

size you are using.  The paper width slider should 

be gently touching both sides of the 

documents.   
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Attention 

 DO NOT load more than 50 sheets of paper 

(18 lb./70 g/m2,) into the ADF.   

 Paper fed into the ADF must be a minimum 

of 2‖ x 2‖ (5.08 x 5.08 cm, W x L). 

 Make sure there are no gaps between the 

document stack and the paper-width slider; 

otherwise, the scanned images may be 

skewed. 

 Although the documents should be loaded 

firmly in place to ensure optimum scanning 

accuracy, they should never be wedged in 

so tightly that the process of feeding them 

through the scanner is strained. 

 DO NOT load additional paper into the ADF 

while the unit is feeding and scanning. 

Loading Business Cards 

1. Load the business cards, headfirst and face 

down, toward the center of the ADF and all the 

way into the ADF until touching the bottom.    

For single-sided scans, load the business cards 

face down.   

For double-sided scans, load the business cards 

in the desired order. 

 

 

2. Adjust the paper width slider to the business card width.  The paper width 

slider should be gently touching both sides of the business cards.   

Loading Plastic Cards 

 

 

Attention 

 Make sure the plastic cards you wish to 

scan are loaded horizontally into the ADF.   

 Max. thickness of each plastic card is 0.76 

mm (ISO 7810 STANDARD), embossed card 

is 1.2 mm. 

 

1. Plastic cards can be embossed credit cards, driver licenses, ID cards, 

insurance cards, Medicare cards or any membership card.  Make sure to 

load the embossed side of the embossed card face down into the scanner. 

Load the plastic card horizontally, headfirst and face down, toward the 

center of the ADF.    

For single-sided scans, load the card face down.   
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For double-sided scans, load the card in the desired order. 

 

2. Adjust the paper width slider to the card width.  The 

paper width slider should be gently touching both 

sides of the card.   

 

 

 

 

Scanning Documents 

There are three different ways to operate the scanner: 

1. By acquiring images from the scanner through our TWAIN interface 

within any TWAIN-compliant application programs. 

2. By scanning from the buttons on the scanner front panel. 

3. By scanning from AmbirScan ADF Execute menu on the screen. 

 

 

Attention 

Before you start scanning, check the 

following: 

 Both your computer and scanner are 

turned on. 

 The  icon appears on the Windows 

system tray. 

 Paper is appropriately loaded into the 

ADF. 

Scanning via TWAIN Interface 

 

The TWAIN program is a very important piece of software that comes with 

your scanner.  This program acts as an interface between the scanner 

hardware and the image-editing software you use to view and edit images. 

It allows you to adjust a number of settings to define the quality of the 

scanned image. 

The following sections describe how to use the bundled document 

management software application (Presto! PageManager 7) to scan via the 

TWAIN interface.  You may also use other TWAIN compatible scanning 

applications to do your scanning projects. 

 

Select the Scan Source: 
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If you have more than one scanner or other imaging devices installed on 

your computer, you need to set this scanner as the default scanning source 

before you acquire image data/scan using a TWAIN compliant program. 

1. For Presto! PageManager 7.1, From the File menu, click Select Source… 

 

2. In the window that opens, choose this scanner and then click the OK 

button to set this scanner as the default scanning source. 

 

 

 

Scan within NewSoft Presto! PageManager 7.1:  

1. Click on the Windows Start button, point to All Programs > Presto! 

PageManager 7.1 and then click Presto! PageManager 7.1 to launch 

the PageManager program. 

2. Within Presto! PageManager, click Tools > Scan Settings > uncheck 

―Suppress TWAIN User Interface‖ > OK. Click File > Acquire Image Data.  

3. In the TWAIN window that opens, select ADF (Front Side) as the Scan 

Type if you want to scan single-sided documents, or select ADF (Duplex) 

to scan double-sided documents. 

4. Adjust the scanning settings.  For ADF (Duplex) scan, you can tailor 

settings individually for front and rear sides of the documents.  Click 

Front Side button to adjust the scanning settings of document front side 

and then click Rear Side button to adjust the scanning settings of 

document rear side. 

 You can enable the Merge Pages function only when you select ADF 

(Duplex) as Scan type and Automatic Size as Page Size to output the 

scan images of both front and rear sides in one image.  After Merge 

Pages is enabled, you can select Horizontally to generate both front 

and rear image data horizontally in a joined image (the rear image will 

be placed at the right side next to the front image), or make the 

selection of Vertically to generate both front and rear image data 

vertically in a joined image (the rear image will be placed below the 

front image). 

5. Load one page of the document and click the Preview button.  The 

scanned image should appear in the Preview Window.  To define the 

margins and crop out sections of the image you don’t want scanned, 

use the mouse to click and drag the corners or sides of the scan area 

borders.  Adjust the scan settings again if the preview image doesn’t 

satisfy your needs. 

6. Load all pages of the document and click the Scan button. 

7. When the scan finishes, click the Exit button to close the TWAIN window.  

The scanned images are displayed in Presto! PageManager, and you 

may perform the image editing tasks. 
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Information 

If you usually scan images with the same 

settings, you can define a scan profile to 

save the settings you have configured by 

entering a name or description for this new 

profile in the white area beside the word 

Profile and then click the Save button. 

Whenever you want to scan similar 

documents and apply the same settings, 

you can just select this profile from the 

drop-down list and click the Scan button. 

Click the Help button within the TWAIN window for more information about 

the settings. 

 

 

Scanning from the Scanner’s Front Panel 

Completing your scanning projects using the scanner buttons is easy and 

convenient.  The number assigned to a scanning task displayed on the 

scanner’s front panel is configured through AmbirScan ADF.  AmbirScan ADF 

offers you quick access to the most frequently-used scanning functions.  

They are especially useful when you need to repeatedly scan with the same 

settings and send images to the same destination.  Before performing your 

first scan via scanner buttons, first configure the button settings with your 

preferences. 

 

Scan from the Scanner Buttons 

1. Place the document or images onto the scanner. (Refer to CHAPTER II. 

Scanning‖ of the Scanner User’s Guide for more information in placing 

paper into the ADF properly.) 

2. Check current button settings by viewing the memo sticker or the 

Button Configuration window.  If needed, you may also modify settings 

to meet your current needs. (Refer to ―View Button Settings‖ and 

―Configure Button Settings‖ below for more information.) 

3. Press the UP or DOWN button to select the desired task. 

4. Press the Scan button. 

The scanner starts to scan immediately, carrying out the corresponding 

action according to settings in the Button Configuration window.  

 

 

Attention 

Only scan text documents with the OCR 

setting. Do not scan a photo using the OCR 

button. 
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Configure Button Settings 

Within the ―Button Configuration‖ window, you can find a row of icons 

running through the left side of the window.  Each icon represents a 

scanning task, and the number underneath corresponds to the function 

number displayed on the scanner front panel.  Nine frequently-used 

scanning tasks are pre-configured for your convenience.  You may, 

however, customize the settings of the nine tasks to best meet your 

preferences.  Follow the steps described below: 

1. Do one of the following to open the Button Configuration window: 

•Double-click the  icon in the Windows system tray. 

• Right-click the  icon in the Windows system tray, and then 

choose Button Configuration… in the pop-up menu that opens. 

2. Select a task number by clicking on the icon. 

3. Select the desired function from the drop-down list of Button Template 

and adjust button settings. 

 

 

Information 

You may use the memo sticker included in 

the box to write customized button number 

settings. 

Click the Help button within the Button Configuration window for more 

information about the settings. 

 

View Button Settings 

There are three ways to view the button settings: 

• Double-click the  icon in the Windows system tray. 

•Right-click the icon in the Windows system tray, and then choose 

Button Configuration… in the pop-up menu that opens. 

• Look at your memo sticker if you wrote down the customized button 

number settings on it. 

 

Scanning from the On-screen AmbirScan ADF Execute Menu 

You may also use AmbirScan ADF’s on-screen Execute menu to perform the 

same scanning tasks.  The AmbirScan ADF program provides a quick and 

convenient way to perform various scanning functions.  Follow the steps 

below: 

1. Place the document or images onto the scanner. 
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2. Check current button settings by viewing the memo sticker or the 

Button Configuration window.  If needed, you may also modify settings 

to meet your current needs. 

3. Right-click the  icon in the Windows system tray, and then choose 

Execute in the pop-up menu that opens. 

4. Click the desired button function item in the pop-up menu. 

The scanner starts to scan immediately and carries out the corresponding 

action according to the Button Configuration you set.   
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CHAPTER III. CARE AND MAINTENANCE 
Your scanner is designed to be maintenance-free.  However, routine care 

and maintenance can keep your scanner working smoothly. 

Cleaning the Scanner 

Paper powder, dust, ink and toner from paper being scanned may make 

the inner document feeder dirty, which leads to poor image quality or 

document-feeding errors.  How often you clean your scanner depends on 

the type of paper and number of pages being scanned. 

Perform the following procedures to clean the scanner surface and the ADF 

unit.  Gently wipe locations described herein.  Do not rub too hard. 

 

 

Warning 

 Before cleaning the scanner, turn off 

the scanner and disconnect the power 

cable and USB cable, and wait a few 

minutes for the glass and/or the inner 

ADF to cool to ambient temperature. 

 Wash your hands with soap and water 

after cleaning the scanner. 

Cleaning Materials 

Have the following cleaning materials ready to clean the scanner: 

 soft, dry, lint-free cloth (or a cotton swab) 

 non-abrasive cleaner—Isopropyl alcohol (95%).  DO NOT use water. 

 

 

Attention 

 Alternatively you can use glass 

cleaner or neutral detergent to clean 

the scanner glass. 

 DO NOT use either products to clean 

the ADF feed roller or pad module. 

Use of other cleaning materials could damage your scanner. 
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Cleaning the ADF 

1. Open the ADF cover by pulling the gray lever.  

 
 

2. Gently wipe the following areas with the cloth dampened with the 

cleaner.  Be careful not to scratch their surfaces. 

 

Clean Feed Roller: 

Wipe the Feed Roller from side to side and then rotate it.  Repeat until its 

entire surface is cleaned. 

 

 

Clean Pad Module: 

Wipe the Pad Module from top to bottom (in the direction of arrow shown in 

below picture).  Be careful not to damage the pick springs of the pad.  

 

Cover lever 

ADF cover 
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Clean ADF Glass:  

 

 

 

 

Attention 

Do not spray cleaner directly onto the 

scanner glass.  Excess liquid residue may fog 

or damage the scanner. 

 

3. Wait for cleaned areas to dry completely. 

4. Close the ADF cover by pushing it back down until it snaps back into 

place.   
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Replacing Consumables 

As a guideline, we recommend replacing the pad module every 20,000 

scans.   

Replacing the Pad Module 

1. Open the ADF cover by pulling the cover lever.  

 
 

 

2. Remove the pad module by squeezing the black tabs on both sides of 

the pad module and pulling it out. 

 

3. Install the new pad module by inserting the tabs on the module into 

their slots on the scanner.   

 

4. Close the ADF cover by pushing it back down until it snaps back into 

place. 

Cover lever 

ADF cover 
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Calibrating the Scanner 
 

 

Attention 

Please uninstall the extended paper width 

sliders before you start the calibration. 

Calibrate the scanner if colors appear in areas that should be white, or 

colors of the scanned image and the original vary a lot. This allows you to 

adjust and compensate for variations that can occur in the optical 

component over time.  

Follow the steps below to calibrate the scanner: 

1. Locate the Calibration Sheet, marked with an arrow on either edge at 

both sides. It is used specifically for ADF Scanning calibration.   

2. Insert the special calibration sheet into the ADF of the scanner, with an 

arrow toward the scanner buttons. 

 
 

 

Attention 

Please insert the special calibration sheet 

included with the scanner.  Alternatively you 

may also use any plain white sheet of paper 

sized in A4 (216 x 297 mm) instead; however, 

the calibration effect may be less beneficial 

than with the special calibration sheet. 

3. Click Start > All Programs > Your scanner model name > Calibration 

Wizard. 
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4. Click Next in the Calibration Wizard that pops up and then click 

Calibrate Now.... 

5. Click the Start button to begin the calibration process. 

Calibration is complete when the scanner pulls the sheet all the way 

through.  After the calibration is complete, click OK and then click Finish. 

Power Save 

To save power, the scanner light source always automatically turns itself off 

after the scanning process is finished. If you won’t be using your scanner for 

a long period of time, shut it down and then disconnect the power cable 

from the power outlet.  

 

 

Information 

 The scanner will enter standby mode 

(sleep mode) after it is idle for 10 

minutes. Simply press any scanner 

button on the scanner panel and the 

scanner will revert to the normal status. 

 From the Windows START menu, point to 

All Programs > Your Scanner Model 

Name, and then click Scanner Utility. 

Refer to the Scanner Utility online help 

to learn more about standby mode. 
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CHAPTER IV. TROUBLESHOOTING 
If you encounter problems with your scanner, please review the installation 

and scanning instructions contained in this guide. 

Before you seek customer service or repair assistance, please refer to the 

information in this chapter and consult our FAQ (Frequently Asked 

Questions) for useful troubleshooting information.  From the Windows START 

menu, point to All Programs > Your Scanner Model Name, and then click 

FAQ. 

Scanner Connection 

The first step to take when troubleshooting connection problems with your 

scanner is to check all physical connections.  The icon, located in the 

Windows system tray, indicates if the scanner software is properly launched 

and the scanner and computer are communicating with each other. 

 

Appearance Status 

 

The program has been successfully launched and the 

scanner is connected with the computer, ready to scan 

images.  

 
The scanner is not connected with the computer or the 

scanner power is not switched on. 

No Display 

You have chosen to terminate the program, whether the 

scanner is connected or disconnected with the 

computer. 

Clearing Paper Jams 

1. Remove any jammed documents still loaded into the ADF. 

2. Open the ADF cover by pulling the cover lever. 

3. Gently but firmly pull the jammed documents out of the ADF.  Try to 

avoid creasing or wrinkling the documents. 
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Attention 

Do not try to pull jammed or half-scanned 

documents out of the ADF without first 

opening the ADF cover.  Doing so may 

permanently damage the ADF. 

4. Close the ADF cover by pushing it back down until it snaps back into 

place.   
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APPENDIX A: SPECIFICATIONS4 

Ambir ImageScan Pro 820i 

Optical Resolution 600 dpi 

Max. Hardware 

Resolution 
600 x 600 dpi 

Scan Modes 

Color: Input 48-bit; Output 24-bit 

Grayscale: Input 16-bit; Output 8-bit 

Black & White: 1-bit  

Technology Color Contact Image Sensor (CIS) 

ADF Capacity 

1. 50 sheets (A4/Letter, 18 lb. or 70 g/m2), maximum thickness 

under 0.2‖ (5mm).  

2. 20 sheets (Business Cards) 

3. Plastic Card, maximum thickness under 1.2 mm. 

Note: Maximum ADF capacity varies, depending upon paper 

weight. 

ADF Scanning Speed 

8 ppm/ 8 ipm (200 dpi, Color mode, A4 Portrait) 

25 ppm/ 50 ipm (200 dpi, Grayscale mode, A4 Portrait) 

25 ppm/ 50 ipm (200 dpi, Black & White mode, A4 Portrait) 

Note: Results may vary depending upon your scanning 

application, computer processor and system memory. 

Scan Area 

(W x L) 

Maximum 8.5‖ x 14‖ (216 x 356 mm)  

Minimum 0.52‖ x 0.52‖ (13.2 x 13.2 mm)  

Acceptable Paper Sizes 

(W x L) 

Maximum  8.66‖ x 14‖ (220 x 356 mm) 

Minimum 2‖ x 2‖ (50.8 x 50.8 mm)  

Acceptable Paper 

Weight for ADF 

14 to 28 lb (50 to 105 g/m2) 

 

Power Adapter 24Vdc, 0.75 A 

Power Consumption 

Operation: < 18 W 

Standby (sleep mode):  < 0.5 W 

Off Mode:  < 0.3 W 

Interface USB 2.0 High Speed 

Operating Temperature 41F to 104F (5C to 40C)  

Relative Humidity 20% to 80% (non-condensing) 

Physical Dimensions 

(WxDxH) 

Without Stacker 

263 x 127.5 x 148 mm (10.36‖ x 5.02‖ x 5.83‖) 

Weight 
Without Stacker: 3.66 lb. (1.66 kg) 

With Stacker: 3.96 lb. (1.8 kg) 

Protocols TWAIN Compliant  

EMI FCC Class B, CE 

                                                 
4
 Hardware specifications may change at any time without prior notice. 
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APPENDIX B: 

CUSTOMER SERVICE AND WARRANTY 
For further assistance, visit our website or call our customer support number. 

One of our representatives will be happy to assist you Monday through 

Friday during office hours. 

To avoid delays, please have the following information ready before calling: 

 Scanner name and model number 

 Scanner serial number (Located on the back of the scanner) 

 Scanner CD version and part number 

 A detailed description of the problem 

 Your current operating system  

 Name of software package(s), version or release number and 

manufacturer of the software 

 Other USB devices installed 

Technical Support 

 

Free Support Through Email & Web 

Visit Ambir’s website at www.ambir.com for online access to technical 

support information including: installation guides, FAQs, troubleshooting tips, 

and driver downloads. Contact email addresses and a chat feature are also 

available online for your convenience in reaching us should you need 

further assistance. 
 

Technical Support by Telephone 

Support is available from 7:00 a.m. – 7:00 p.m. Central Time Monday-Friday 

by dialing (630) 530-5400 or (800) 915-9930, option 3. For all Ambir scanners 

you can speak directly to a technical support representative or leave a 

message for a call back. You will be connected to a highly trained, friendly 

and professional support agent who will work with you to resolve your issue. 

For expediency when you call please be in front of your system with your 

software and documentation handy for troubleshooting. 

*We will make every effort to respond to telephone support calls within 1 

business day. However, we strongly suggest that you make initial contact via 

email with an explanation of the problem you are experiencing and a call-

back number should we need to speak to you directly. 
 

Product Warranty Information   
 

Statement of Limited Warranty for the United States, Canada and European 

Economic Community: 
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Products – ImageScan Pro 820i 

Warranty Period – 1 year   

*Contact your place of purchase for warranty service information 

 

 

Warranty for Products 

Ambir Technology warrants our products against defects in materials and 

workmanship to the original purchaser for a period of one (1) year from the 

date of the original purchase. This warranty is limited to repair or 

replacement of the product, and the remedy provided to the purchaser for 

warranty service is the sole discretion of Ambir Technology. 

 

Extent of Warranty 

Any use of the product for a purpose in which it is not intended, and/or 

purchaser modifications, alterations, and/or repairs to the product, will 

constitute misuse and are not subject to the warranty. The warranty does 

not cover the repair or exchange of a product resulting from accident, 

unsuitable physical or operating environment, or failure caused by a 

product for which the Ambir is not responsible.  

 

Items Not Covered by the Warranty 

Host computer operating systems, application programs or hardware 

configurations are not covered. 

 

For customer service or further warranty information please email or call 

Ambir directly. Please provide product model name and number, place 

and date of purchase, your name, daytime telephone number and a 

description of the difficulty you are experiencing. You will normally receive a 

written email response or call-back within 1 business day. 

 

 

 

Ambir Technology 

918 N. Oak Lawn Ave. 

Elmhurst, IL 60126 USA 

Toll Free: (800) 915-9930 

Main Number: (630) 530-5400 

Technical Support: (630) 530-5400 option 3 

www.ambir.com 
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FCC Radio Frequency Statement 

This equipment has been tested and found to comply with the limits for a 

Class B digital device, pursuant to part 15 of the FCC rules. These limits are 

designed to provide reasonable protection against harmful interference in a 

residential installation. 

This equipment generates, uses and can radiate radio frequency energy 

and, if not installed and used in accordance with the instructions, may 

cause harmful interference to radio communications. However, there is no 

guarantee that interference will not occur in a particular television 

reception (which can be determined by turning the equipment off and on), 

the user is encouraged to try to correct the interference by one or more of 

the following measures: 

 Reorient or relocate the receiving antenna. 

 Increase the separation between the equipment and receiver. 

 Connect the equipment to an outlet on a circuit different from that 

which the receiver is connected. 

 Shielded interconnect cables and shielded power cord which are 

supplied with this equipment must be employed with this equipment to 

ensure compliance with the pertinent RF emission limits governing this 

device. 

 Consult the dealer or an experienced radio/TV technician for help if 

the conditions persist. 

 Changes or modifications not expressly approved by the 

manufacturer or authorized service center could void the user’s 

authority to operate this equipment. 

This device complies with Part 15 of the FCC Rules.  Operation is subject to 

the following two conditions: (1) this device may not cause harmful 

interference, and (2) this device must accept any interference received, 

including interference that may cause undesired operation. 
 
 
 

 

 


	OLE_LINK4
	OLE_LINK7
	OLE_LINK8
	OLE_LINK1
	OLE_LINK6
	OLE_LINK5

